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Introduction

La Mandrake 5.3 et Gimp 1.0.4 servent de référence a cet article. Arborescence, répertoires ou menus décrits peuvent
donc différer selon les versions de produits utilisés. Sans doute une adaptation a des configurations spécifiques

est-elle a prévoir.
Pour parler des caractéeres d'imprimerie, on dira indifféremment polices ou fontes.
Pour parler des motifs de remplissage, on dira tout aussi indifféeremment motifs ou patterns.

Lorsque I'on parlera de Xfree86, faisant fi de I'appellation officielle, on dira X.

Lorsque I'on en appellera & Midnight Commander, qui autorise la gestion de fichiers sans nécessité de connaitre les
fonctions de base de Linux et leur pléthore d"options,on dira MC. Tout utilisateur de Norton Commander et Xtree Gold
sous Dos, ou de WinCommander sous Windows, se retrouvera en terrain connu. Jusqu'aux touches de fonction qui ont
recu la méme affectation dans MC que dans WinCommander! Soyons donc pragmatiques. Sans doute vaut—il mieux

faire balourd et fonctionnel que sophistiqué et inopérant!
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Etape 1:

Installer les Freefont et les Sharefont

Les script—fu utilisent par défaut des polices que les différentes distributions n'installent pas toujours automatiquement.
Ces polices sont réparties dans deux paquetages: Freefont et Sharefont. L'un est libre, l'autre est distribué selon le
principe du shareware, mais tous deux sont fort intéressants. lls apportent sans conteste une plus-value a X en
soignant sa présentation.
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Ces deux paquetages sont disponibles en archives .tgz auprées de Christoph Lameter a I'adresse

suivante: clameter@waterf.org.

Cependant plusieurs distributions les proposent dans un répertoire /Contrib, de méme que des cédéroms de
couverture de magazines informatiques. Ainsi Linux Magazine 9 les proposent dans le répertoire /Gimp/fonts de son
CD d'accompagnement.

Supposons que l'on dispose de ce cédérom et que I'on soit en mode console (mode texte donc). Procéder alors
comme suit:

¢ 1.1 "mounter" le CD

1.2 lancer MC

1.3 Dans la fenétre de droite, pointer le répertoire / Gimp/fonts du CD

1.4 Dans la fenétre de gauche (ou vice versa) pointer le répertoire /usr/X11R6/lib/X11/fonts du disque dur
1.5 Copier (F5) les fichiers freefont.tgz et sharefont.tgz sur le disque dur dans le répertoire pointé

1.6 Décompresser les fichiers (F2 ouvre un menu, choisir décompresser l'archive dans Rep)

Si cette option n'est pas dans le menu, sortir de MC (F10), le curseur étant positionné sur la fenétre pointant les fichiers
copiés. Sil'on a pris la peine d'ajouter la ligne suivante dans .bashrc :

mc () MC="/usr/bin/mc -P "$@"*; [ -n "$MC" ] && cd "$MC"; unset MC ;

on se retrouve dans le répertoire pointé. Sinon, s'y rendre par

cd /usr/X11R6/lib/X11/fonts

et lancer la commande de décompression:
tar xvfz *.tgz

On obtiendra alors deux nouveaux répertoires, 'un appelé: freefont et I'autre appelé: sharefont. Les fichiers
compressés .tgz peuvent étre effacés maintenant.
Freefont contient 79 polices, presque toutes utilisables, et sharefont contient 22 polices.
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Chaque répertoire contient en outre un fichier spécial et obligatoire appelelé fonts.dir, qui décrit pour X les
caractéristiques des polices contenues dans ce répertoire. Point n'est besoin donc d'exécuter la commande mkfontdir

pour générer ce fichier.
Les polices seront prises en comptes par X au prochain lancement de celui—ci a condition qu'on lui indique qu'il doit les

utiliser. Pour cela, il convient d'ajouter dans /etc/X11/XF86Config, a la sections " Files" les lignes suivantes:

FontPath "/usr/X11R6/lib/X11/fonts/freefont"
FontPath "/usr/X11R6/lib/X11/fonts/sharefont”

Certains XF86Config decrivent FontPath sur une seule ligne, auquel cas les différents chemins sont séparés par ":" tel

que:
FontPath "/usr/X11R8/lib/X11/misc:unscaled:/usr/X11R6/lib/X11/fonts/freefont:/usr/X11R6/lib/X11....."

Si I'on est en session graphique, et non en mode console, la manipulation ci-dessus reste valable a ceci pres qu'elle
s'effectuera dans un terminal (rxvt, kvt, wmterm...). Mais les polices ne seront pas immédiatement prises en compte;
elles ne le seront que lors du redémarrage de X, ou bien si I'on exécute dans le terminal encore ouvert les commandes

suivantes:

xset fp+ /usr/X11R6/lib/X11/fonts/freefont
xset fp rehash

xset fp+ /usr/X11R6/lib/X11/fonts/sharefont
Xset fp rehash
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Résultats

On verifiera que les polices sont prises en charge en lancant xfontsel, ou mieux, parce que moins rustique, gtkfontsel
ou tout simplement le gestionnaire de polices de KDE.

Les polices sont alors utilisables par toute (pas vraiment) application X.

Ces polices peuvent étre regroupées dans un tableau, comme dans cet article, en utilsant Gimp avec la commande:

xtns> Script-Fu> Utils> Font Map.

Attention: outil impitoyable. La moindre erreur lors de I'entrée d'un nom de police vous refoulera sans pitié avec
obligation de tout recommencer. Le mieux est d'opérer avec le gestionnaire de police de KDE ouvert en méme temps
qgue Gimp, parce qu'il indiquera le nom correct de la fonte tout en la visualisant dans le champ échantillon. La figure3
montre certaines de ces polices, utiles pour créer des logos fantaisistes ou créer des lettrines.
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Etape 5:

Utiliser des True Type

Les polices que I'on vient d'installer sont intéressantes, mais qui n'a pas sur son disque dur une partition Windows et sa
cohorte de fontes True Type de fort belle facture? Il est donc Iégitime de vouloir les utiliser.
Les derniéres distributions de Linux, et celles a venir encore plus, prévoient naturellement leur emploi. Il n'en est pas

de méme sur une distribution plus ancienne, comme la Mandrake 5.3 (qui n'a pourtant guére plus de 6 mois).
Cependant, au moins une solution existe. Il s'agit d'un serveur appelé Xfstt (un simple fichier exécutable de 130 Ko
aprées compilation) disponible,entre autres, a I'adresse suivante: ftp://sunsite.unc.edu/pub/Linux/X11/fonts/.

Il s'agit d'une archive appelée Xfstt—0.9.10.tgz de 80 Ko. Le numéro de version indique que le programme n'est pas
encore finalisé, mais il fonctionne sans gros problemes.

Avant compilation, il faut préparer le terrain en créant un répertoire destiné a recevoir des fontes TrueType, tel que
lusrl/ttfonts (mkdir /usr/ttfonts ou F7 dans MC). Ensuite, il faut copier dans ce répertoire les polices a utiliser, ou créer
un lien symbolique (Dans MC, F9, File puis SymLink) pointant vers le répertoire Fonts de Windows. Dans ma
configuration, /usr/ttfonts contient le lien ~winfonts pointant vers /mnt/Win98/windows/fonts, étant entendu que

/mnt/Win98 est le point de montage de ma partition Windows.
La compilation du programme peut alors commencer; a cet effet, se rendre dans /tmp/xfstt0910 créé lors de la

décompression de l'archive et exécuter ensuite la commande:

make xfstt && make install
Quand le processus est terminé, le fichier binaire exécutable xfstt produit est installé dans /usr/X11R6/bin. Il convient

maintenant d'indiquer au serveur xfstt quelles polices True Type il aura a utiliser. A cette fin, exécuter la commande:
xfstt ——sync

Cela a pour effet de créer deux fichiers de description dans /usr/ttfonts appelés ttinfo.dir et tthame.dir.

Le serveur se lance par la commande: xfstt &.

Mais rien ne semble passer a I'exécution de la commande: ces fontes n'étant utilisées que par X, elles ne sont donc
pas disponibles en mode console, et si I'on est en mode graphique, il faut indiquer a X de les prendre en charge. Cela
s'obtient par la commande:

xset +fp unix/:7100

Vérifier ensuite avec xfontsel ou le gestionnaire de polices de KDE que les TrueType sont alors disponibles; elles
devraient I'étre pour toutes (presque!) les applications X. SatrOffice5 les accepte pour StarDraw, Starlmpress,
StarCalc... mais bizarrement pas pour StarWriter, a moins qu'il y ait une option a activer, laquelle aura échappé a ma
sagacité :-).

En tout cas, elles sont utilisables pour Gimp
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Polices TrueType dans Gimp

La documentation du programme indique la possibilité d'ajouter dans XF86Config, a la section "Files" la ligne suivante:
FontPath "unix/:7100"; cela ne marche pas chez moi; il est dit également de lancer xfstt avant le démarrage d'une
session X, ce qui suppose d'exécuter les autres commandes dans un terminal, au risque d'en oublier. Le mieux est
d'automatiser les taches en écrivant deux petits scripts, I'un pour actver le serveur, I'autre pour le désactiver. On
n'oubliera pas de rendre ces scripts exécutables (dans MC, F9 puis File et Chmod) et de les sauver dans /usr/local/bin,
par exemple. Le sript d'activation pourrait s'appeler ttf et le script de désactivation pourrait s'appeler dttf. Le premier
contiendrait les lignes suivantes:

#!/bin/sh

xfstt ——sync

xfstt &

xfstt +fp unix/:7100

Le second contiendrait simplement:

#!/bin/sh
xset —fp unix/:7100

C'est la solution que j'utilise: elle fonctionne.
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Etape 7:

Créer des Patterns

Les patterns (motifs) ne sont rien d'autres que des fichiers d'image bitmap au format .pat spécifique (pour ne pas dire
propriétaire) de Gimp, qui servent a remplir une surface a l'aide du "pot de peinture”. lls sont sauvegardés dans les
répertoire /usr/local/share/gimp/patterns. Ceux que I'on crée peuvent étre sauvés a cet emplacement, auquel cas tous
les utilisateurs y auront accés, ou dans son répertoire personnel ~/.gimp/patterns, auquel cas seul root et soi-méme y
auront acces.

Supposons que l'on veuille utiliser la figure5 pour "tapisser"” le fond (background) d'une image.

On peut le faire manuellement par copier—coller, mais l'opération est longue et peu précise: les motifs seront-ils
juxtaposés au pixel pres? Il vaut mieux laisser a Gimp le soin de le faire, et il le fera si I'image a répéter est un motif
pour lui, c'est & dire un fichier .pat.

Ce n'est actuellement pas le cas. On y remédie en procédant comme suit:

« Charger le candidat motif dans Gimp
« Le sauver dans l'un des répertoires ci—dessus, en prenant soin d'indiquer que I'on veut une sauvegarde au
format .pat, en faisant: clic droit sur limage> Save as> By extension> Pat > ~/.gimp/patterns/Tux1.pat> ok

Avant de sauver, Gimp demande de donner un nom au motif, qui n'est pas le nom de sauvegarde, mais un identifiant;
par défaut, le motif est défini comme GIMP Pattern. Appelons-le Tuxdor
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Quittons Gimp, puisque ce nouveau motif ne sera utilisable qu'au redémarrage, et relancons-le.
Dans la boite a outils, cliquer sur File>Dialogs>Patterns. La boite Patterns Selection apparait et affiche des écantillons
minuscules des motifs disponibles; si I'on clique sur un échantillon, celui-ci s'affiche momentanément a I'échelle 1 sous

le pointeur de la souris. De plus, le fait de cliquer sur un échantillon sélectionne le motifqu'il représente.
Recherchons le motif Tuxdor, en fin de liste donc, puisque les patterns sont classés par ordre alphabétique, et
sélectionnons-le pour I'utiliser.

Créer un dessin de travail par File>New>Width 288 Height 286 (dimension pour 4 motifs).

Double cliquer sur Fill with a color or pattern (le pot de peinture) Sélectionner Pattern Fill
Cliquer n'importe ou dans I'image vide et celle—ci se remplit de Tux d'Or.
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Cependant le remplissage n'est pas esthétique: les "coutures" entre motifs sont visibles. Cela vient du motif lui-méme,
qui n'a pas été créé pour effectuer un nappage sans raccord. Fabriquons—en un. Ouvrir de nouveau la figure5 Clic droit
sur l'image> Filters> Map> Make Seamless On obtient un nouveau motif

e

Le sauvegarder au méme emplacement comme Tux2.pat, avec l'identifiant TuxTile. Quiiter Gimp, relancer, préparer
une image de 432x392 La remplir avec le motif TuxTile On obtient alors une image sans raccord mais avec un aspect
un peu militaire (qui peut étre recherché d'ailleurs, selon la destination de I'image).L'aspect est cependant de meilleure

qualité que précédemment.

h@

‘."

(axe Ba !m@ X M@

i
'v..

Q® Page précédente
Sommaire

10


mailto:andre@linuxgraphic.org
http://www.linuxgraphic.org
didact.html

FREEFONT, TRUE TYPE ET PATTERNS DANS GIMP
Par André Pascual

[ifraphicorg

introduction—Q-Q-©-0-0-0-0 OO

Etape 10:

On pourrait vouloir malgré tout une image plus douce, plus fondue.Fabriquons le motif adéquat:

o Ouvrir de nouveau la figure5
« Clic droit sur l'image> Filters > Map> lllusion> 8> OK
« On obtient un nouveau motif

g

« Le sauvegarder au méme emplacement comme Tux3.pat, avec l'identifiant Tuxlllus
« Quitter Gimp, relancer, préparer une image de 432x392

o Le remplir avec le motif Tuxlllus

« On obtient alors une colonie de Tux. Est—ce plus beau? Affaire de golt
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Conclusion provisoire

L'image finale montre I'utilisation que I'on peut faire de ces polices de caractéres venues d'ailleurs, et des motifs autres
que les motifs standards de Gimp. Les textes sont réalisés avec le Sript—Fu logo; certes, ils ont été quelque peu
travaillés pour offrir cet aspect, mais faire la méme chose est a la portée de tous. Il suffit d'explorer les innombrables
possibilités du logiciel, et de s'amuser avec.
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